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INTRODUCCIÓN 
LA PLATAFORMA ECLIPSE 
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No sólo un IDE… 
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Instalación 
�  Se requiere la JDK 1.6 o superior 
� Acceder a http://www.eclipse.org/ 
� Entrar en Downloads 
� Clic en Eclipse Modeling Tools 
� Descargar versión Win/Mac/Linux, 32/64 
� Ajustar parámetros de memoria 

XX:MaxPermSize y Xmx en eclipse.ini 
(opcional) 

�  Inicia eclipse 
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Eclipse IDE 
� Eclipse es una plataforma de desarrollo 

integrada de código abierto 
multiplataforma. 

� Eclipse fue desarrollado originalmente por 
IBM.  Ahora es mantenido por la 
Fundación Eclipse. 

� Participan empresas como HP, Intel, 
Motorola, etc.  

� Dispone de una gran comunidad de 
usuarios. 
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Eclipse IDE 

� Es un entorno de desarrollo de software 
escrito en su mayor parte en Java. 

�  Ideal para el desarrollo de aplicaciones 
web, móviles o de escritorio con Java. 

�  Soporte al refactoring y análisis de código. 
�  Integración con servidores web (Tomcat, 

Glassfish) 
� La propia plataforma sirve para construir 

aplicaciones de cliente enriquecidas. 
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PROYECTOS 
LA PLATAFORMA ECLIPSE 
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Runtimes Eclipse 
�  Eclipse Communication Framework   
�  EclipseLink Project   
�  Equinox   
�  embedded Rich Client Platform   
� Gemini - Enterprise Modules Project   
�  Jetty - Servlet Engine and Http Server   
�  Rich Ajax Platform   
�  Riena Project   
�  SMILA   
�  Virgo   
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Eclipse Web Tools Platform Project   

�  WTP Common Tools   
�  Dali Java Persistence 

Tools   
�  WTP EJB Tools   
�  WTP Incubator   
�  WTP Java EE Tools   
�  JavaScript 

Development Tools   
�  JavaServer Faces   

�  Enterprise Tools for 
the OSGi Service 
Platform   

�  Pave   
�  Webtools Releng   
�  Server Tools   
�  WTP Source Editing   
�  Web Services Tools  
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SOA Platform Project   
�  BPEL Designer   
�  BPMN2 Modeler Project   
�  BPMN modeler   
�  eBAM   
�  eBPM   
�  Java Workflow Tooling   
� Mangrove - SOA Modeling Framework   
�  SCA Tools   
�  Stardust   
�  Swordfish   
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Tools Project   

�  AJDT - AspectJ 
Development Tools 
Project   

�  AspectJ   
�  Ajax Tools 

Framework (ATF)   
�  C/C++ Development 

Tooling (CDT)   
�  WindowBuilder   

�  Graphical Editing 
Framework (GEF)   

�  Memory Analyzer   
�  Eclipse Orbit Project   
�  PHP Development 

Tools   
�  Parallel Tools 

Platform (PTP)   
�  Target Management   
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Technology Project 
�  Dynamic Languages 

Toolkit   
�  Eclipse Git Team 

Provider   
�  Eclipse Process 

Framework Project   
�  Eclipse Tools for 

Microsoft Silverlight   
�  The Eclipse Examples 

Project    
�  Subversive - SVN Team 

Provider   

�  Graphical Editing 
Framework 3D   

�  Hudson   
�  Eclipse IAM 

(Integration for Apache 
Maven)   

�  IDE for Education   
�  Linux Tools   
�  Open Financial Market 

Platform   
�  Open Healthcare 

Framework 
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Otros proyectos 

� Eclipse Project 
� Data Tools Platform  
� Business Intelligence and Reporting Tools 

(BIRT) 
� Mylyn  
� Test and Performance Tools Platform 

Project  
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Eclipse Modeling Project (EMP) 

The Eclipse Modeling Project 
focuses on the evolution and 
promotion of model-based 
development technologies 
within the Eclipse community 
by providing a unified set of 
modeling frameworks, 
tooling, and standards 
implementations. 
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COMPONENTES 
LA PLATAFORMA ECLIPSE 
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Workbench 
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Workspace 
�  Representa el espacio de trabajo del usuario. 
�  Se trata de un directorio local de la máquina 

donde se guardan los ficheros de trabajo. 
� Utiliza metadatos (ocultos para el usuario) 

para llevar el histórico de modificaciones en 
los recursos y recordar las preferencias del 
usuario. 

� Detecta cambios externos realizados 
directamente en el sistema de ficheros. 
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Asistentes 
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Los asistentes (wizards) guían al usuario a la hora de 
llevar a cabo un conjunto de tareas: crear un nuevo 

proyecto, hacer refactoring de código, etc. 



Editores 
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Componente visual utilizado para editar los datos de un 
recurso determinado. Los editores pueden ser textuales, 

gráficos o basados en formularios. 
 



Vistas 
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Componentes visuales que permiten navegar a través de 
una lista o jerarquía de elementos. También presentan 

propiedades específicas para para el editor activo. 



Vistas (II) 
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Window → Show View 



Perspectivas (I) 
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Las perspectivas son una colección de vistas y 
editores 



Perspectivas (II) 
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Window → Open Perspective 



ARQUITECTURA 
LA PLATAFORMA ECLIPSE 
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Arquitectura 

�  Eclipse se compone de 
una base de código 
(kernel) y un conjunto 
de extensiones 
adicionales (plug-ins). 

�  La GUI de Eclipse se 
compone de widgets, 
desarrollados con SWT 
y utilizando un MVC 
con JFace. 
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Plug-in Development Environment 
(PDE) 
� Eclipse permite extender la funcionalidad 

del IDE mediante plugins.  
� Utilizando PDE podemos crear y/o editar 

editores, vistas, menús y asistentes del 
workbench de Eclipse  

� Eclipse se basa en la tecnología OSGI, 
para proporcionar una arquitectura 
completamente modular. 

17/10/13 PL2 - La plataforma Eclipse 27 



Componentes de un Plug-in 
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Cada plugin define su propia API (conjunto de clases públicas), 
las dependencias con otros plugins, los puntos de extensión 
(para que otros plugins lo extiendan) y las extensiones que 

aportan (contribuciones a otros plugins). 



Plug-ins Eclipse 

�  Soporte a lenguajes de programación 
distintos de Java: PHP, C++, Ruby,  Latex, 
etc. 

� Edición de modelos basados en lenguajes 
de la OMG:  UML, BPMN, etc. 

� Control de versiones: SVN, GIT, etc. 
�  Integración con sistemas de gestión de 

tareas: Bugzilla, Trac, JIRA, etc. 
� Etc. 
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Eclipse para todos 
� Eclipse IDE for Java EE Developers 
� Eclipse IDE for JS Web Developers 
� Eclipse for RCP and RAP Developers 
� Eclipse IDE for C/C++ Linux Developers 
� Eclipse for Testers 
� Eclipse IDE for Parallel Application 

Developers 
� Eclipse Modeling Tools 
� … 
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Rich Client Platform (RCP) 

� Desde la versión 3.0, podemos utilizar la 
propia plataforma para crear aplicaciones 
de escritorio extensibles. 

� Estas aplicaciones (RCP) se basan en el 
kernel de Eclipse y un conjunto de plugins 
seleccionados o desarrollados. 

�  Se distribuyen como aplicaciones 
independientes. 
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Eclipse IDE y Aplicaciones RCP 
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Eclipse IDE 

Aplicación RCP 

* Lars Vogel 



Aplicaciones basadas en Eclipse 

� Adobe Flex Builder 
�  IBM Rational Method Composer, 
� MyEclipse 
�  IBM Lotus Notes 8 
�  SpringSource Tool Suite 
� Etc. 
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DESARROLLO DE UN 
PROYECTO JAVA 

LA PLATAFORMA ECLIPSE 
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Creación de un proyecto Java 
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File → New → Java Project 
Es preciso definir, al menos, el nombre del proyecto y el 

entorno de ejecución de Java (JRE o JDK) 



Configuración del proyecto 
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Estableceremos la carpeta del código fuente (Source), las 
dependencias con otros proyectos del workspace (Projects) 
y con JARs externos (Libraries) y el orden de compilación 

(Order and Export) 



Creación de la primera clase Java 
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File → New → Class 
Definimos nombre de la clase, paquete donde se almacenará, 

modificadores de acceso, superclases, interfaces a implementar y si 
queremos añadir method stubs y comentarios  



Escribiendo código 
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El editor de código de Eclipse ofrece autocompletado, 
quick fixes, coloreado de sintaxis e inclusión de plantillas de 
código y comentarios (JavaDoc), entre otras capacidades. 

 



Mejorando el código 
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Source Refactoring 



Compilación y ejecución 

� Eclipse compila “al vuelo” los ficheros 
fuente que estamos modificando. 

� Para ejecutar, tenemos que seleccionar la 
clase con el método main deseado y luego 
Run As → Java Application en el menú 
contextual (botón derecho). 

� La vista Console, muestra la salida de la 
aplicación 
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Depuración de código 
�  Eclipse ofrece una completa perspectiva de 

depuración, incluyendo: 
◦  Sesión de depuración 
◦  Puntos de ruptura (breakpoints) 
◦  Inspección de variables/expresiones 

�  Control de la ejecución 
◦  Debug: inicia la depuración 
◦  Step into: ejecuta la instrucción, entrando en métodos 
◦  Step over: ejecuta la instrucción, sin entrar en métodos 
◦  Step return: ejecuta hasta final del método actual 
◦  Pause: detiene la ejecución 
◦  Resume: continúa con la ejecución de la aplicación 
◦  Terminate: finaliza el proceso 
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DESARROLLO DE UN 
PLUG-IN 

LA PLATAFORMA ECLIPSE 
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Creación de un plug-in 
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Creación de un plug-in (II) 
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Creación de un plug-in (III) 
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Creación de un plug-in (IV) 
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Test del plug-in 
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Test del plug-in (II) 
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Test del plug-in (III) 
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Test del plug-in (IV) 
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DESARROLLO DE UNA 
APLICACIÓN RCP 

LA PLATAFORMA ECLIPSE 
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Creación de una aplicación RCP 
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Creación de una aplicación RCP (II) 
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Creación de una aplicación (III) 
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Test de una aplicación RCP 
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Test de una aplicación RCP (II) 

17/10/13 PL2 - La plataforma Eclipse 56 



RESUMEN 
DESARROLLO DE EDITORES CON ECLIPSE 
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¿Qué hemos aprendido hoy? 

� Conocer Eclipse y sus proyectos 
principales 

� Componentes principales del IDE 
� Arquitectura modular basado en un 

kernel y un conjunto de plugins. 
� Desarrollar plugins dentro del propio IDE 

o como aplicaciones independientes a 
partir de unas plantillas. 
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